Inlämningsuppgift:
Praktisk översättning och terminologi

Uppgiften består av fem texter som ska översättas. Texterna är följande:

Text 1: Romanutdrag (amerikansk, början av 60-talet)
Text 2: Romanutdrag (irländsk engelska, 90-tal)
Text 3: Sonett från elisabetansk tid (15-1600-tal)
Text 4: Ett utdrag ur en användarmanual från Microsoft.
Text 5: Instruktion för GPS-funktion i mobiltelefon.

För text 4 och 5 gäller att du först ska identifiera vad du anser vara termer i texten och sedan skapa en termlista med översättningar för dessa termer för varje text. Termistorna bifogas sedan till de inlämnade översättningarna.

Obs! Till varje översättning vill jag att du skriver en kommentar med dina reflektioner kring uppgiften (t.ex. vad som var svårt, vilka val och överväganden du gjort osv.)

Text 3 kommer att kräva speciella överväganden mellan form och innehåll.

Tips när det gäller Microsoftöversättningen: skriv direkt i Word-dokumentet så kan du få samma format som originalet.

Skicka in dina översättningar med reflektioner och (i förekommande fall) termistor senast den 1 November kl. 17 till lars.ahrenberg@liu.se.

Lycka till!

Lars
Boys are playing basketball around a telephone pole with a backboard bolted to it. Legs, shouts. The scrape and snap of Keds on loose alley pebbles seems to catapult their voices high into the moist March air blue above the wires.

Rabbit Angstrom, coming up the alley in a business suit, stops and watches, though he’s twenty-six and six three. So tall, he seems an unlikely rabbit, but the breadth of white face, the pallor of his blue irises, and a nervous flutter under his brief nose as he stabs a cigarette into his mouth partially explain the nickname, which was given to him when he was too was a boy.

He stands there thinking, the kids keep coming, they keep crowding you up. His standing there makes the real boys feel strange. Eyeballs slide. They’re doing this for their own pleasure, not as a demonstration for some adult walking around town in a double-breasted cocoa suit. It seems funny to them, an adult walking up the alley at all.
Where’s his car?

The cigarette makes it more sinister still. Is this one of those going to offer them cigarettes or money to go out in back of the ice plant with him? They’ve heard of such things but are not too frightened; there are six of them and one of him.

The ball, rocketing off the crotch of the rim, leaps over the heads of the six and lands at the feet of the one. He catches it on the short bounce with a quickness that startles them. As they stare hushed he sighs squinting through blue clouds of weed smoke, a suddenly dark silhouette like a smoke-stack in the afternoon spring sky, setting his feet with care, wiggling the ball with nervousness in front of his chest, one widespread pale hand on top of the ball and the other underneath, jiggling it patiently to get some adjustment in air itself. The moons on his fingernails are big. Then the ball seems to ride up the right lapel of his coat and comes off his shoulder as his knees dip down, and it appears the ball will miss because though he shot from an angle the ball is not going toward the backboard. It was not aimed there. It drops into the circle of the rim, whipping the net with a ladylike whisper.
Text 2:
George Best had signed my book. My da hadn’t said anything about the autograph. He’d just given it to me and said Happy Birthday and kissed me. He’d left me to find it for myself.

I brought the book in to my da to let him know I’d found the autograph and it was brilliant, easily the best thing I’d ever got for a present. It was called A Pictorial History of Soccer. It was huge, much fatter than an annual, real heavy. It was a grown-up’s sort of book. There were pictures, but loads of writing too; small writing. I was going to read all of it.

– I found it, I told him.
My finger was in the book, where George Best’s autograph was. My da was sitting in his chair.
– Did you? he said. – Good man. What?
– What?
– What did you find?
– The autograph, I told him.
He was messing.
– Let’s see it, he said.
I put the book and opened it on his knees.
– There.
My da rubbed his finger across the autograph. George Best had great handwriting. It slanted to the right; it was long and the holes were narrow. There was a deadstraight line under the name, joining the G and the B, all the way to the T at the end and a bit further. It finished with a swerve, like diagram of a shot going past a wall.
– Was he in the shop? I asked my da.
– Who?
– George Best, I said.
Worry began, a ball in my stomach but he answered too quickly for it to grow.
– Yes, he said.
– Was he?
– Yes.
– Was he; really?
– I said he was, didn’t I?
That was all I needed for certain.
He didn’t get annoyed when he said it, just calm like he’d said everything else, looking right at me.
– What was he like?
I wasn’t trying to catch him out.
He knew that.
– Exactly like you’d expect, he said.
– In his gear?
That was exactly what I’d have expected. I didn’t know how else George Best would have dressed. I’d seen a colour picture of him once in a green Northern Ireland jersey, not his usual red one, and it had shocked me.
– No, said Da. – He -, a tracksuit.
– What did he say?
– Just –
– Why didn’t you ask him to put my name on it?
I pointed to George Best’s name.
– As well.
– He was very busy, said my da.
– Was there a huge queue?
– A huge one.
That was good; that was right and proper.
– Was he in the shop just for the day only? I asked.
– That’s right, said my da. – He had to go back to Manchester.
– For training, I told him.
– That’s right.

A year after that I knew that it wasn’t George Best’s real autograph at all; it was only printing and my da was a liar.
My love is as a fever longing still,  
For that which longer nurseth the disease,  
Feeding on that which doth preserve the ill,  
Th’ uncertain sickly appetite to please:

My reason the physician to my love,  
Angry that his prescriptions are not kept  
Hath left me, and I desperate now approve,  
Desire is death, which physic did except.

Past cure I am, now reason is past care,  
And frantic-mad with evermore unrest,  
My thoughts and my discourse as mad men’s are,  
At random from the truth vainly expressed.  

For I have sworn thee fair, and thought thee bright,  
Who art as black as hell, as dark as night.
Table Basics

Whether you store a few phone numbers or thousands of records for a company database, you store your data in tables. For example, a table that contains a phone list might contain names and phone numbers. Before creating other objects for your database, such as queries or forms, you must create tables.

This chapter explains how to design a table to store your data. It also explains how to create relationships between the tables you create, so that Microsoft Access can relate data in queries, forms, and reports.

What Is a Table?

A **table** is a container for data about a particular subject, such as employees or invoices. Each **record** in a table contains information about an individual thing, such as a specific employee. The records in a table are made up of **fields**, such as names and phone numbers.

You can have many tables in your database, each storing information about a different subject. Each table can contain data of many types, including text, numbers, dates, and pictures. These are common examples of tables you might create:

- Mailing list containing your company’s customers and their addresses.
- Schedule containing dates, times, and locations of meetings or events.
- Catalog of items you sell, including prices and pictures for each item.
- Table containing results of scientific experiments.
- Reference table of tax rates or freight costs.
- Inventory of equipment or stock on hand.

If you are designing a large database with many tables, you should plan your database carefully to avoid making too many changes later. For information on planning your database, see Chapter 2, “Designing a Database.”

Creating a Table

When you first create a table, it is an empty container for data. You design the table to contain the specific type of data you want to store, such as names and addresses. After you save your table, it’s ready for you to enter data.

The easiest way to create most common tables for business or personal use is with the Table Wizard. With the Table Wizard, you can choose from specific table types such as business contacts, household inventory, or medical records. The Table Wizard asks you questions about the fields you want in your table, then creates the table for you. You can also create a table on your own without using the Table Wizard.

**To create a table with the Table Wizard**

1. In the Database window, click the Table button (or choose Tables from the View menu).
2. Choose the New button.
Microsoft Access displays the New Table dialog box.

3. Choose the Table Wizards button.
4. Follow the directions in the Wizard dialog boxes for adding fields to your table.

When you’re finished creating your table, you can select an option in the Table Wizard to open the table in either Design view, to view or modify the table’s design, or Datasheet view, to begin entering data in the table. You can also select an option to create a new form for viewing data in the table.

Note You can customize the Table Wizard using the Add-In Manager. (From the File menu choose Add-ins, and then choose Add-In Manager. Select Table Wizard and then choose the Customize button.) For more information on add-ins, see Chapter 3, “Starting Up and Managing Database Objects.”

To create a table without the Table Wizard

1. In the Database window, click the Table button (or choose Tables from the View menu).
2. Choose the New button.
   Microsoft Access displays the New Table dialog box.
3. Choose the New Table button.
   Microsoft Access opens a blank Table window in Design view.

Note You can also create a table by importing data, or you can attach an external table to your database. For example, if you have data in another application, such as dBASE or Paradox, you can use the Import command to create a Microsoft Access table for this data. For information on importing or attaching data, see Chapter 9, “Importing, Exporting, and Attaching.”
SuperFinder Navigator – Quick Start Guide

This is a quick start guide. More information on how to use the SuperFinder Navigator can be found at mysuperfinder.com and superfinder.com/manuals. Before you can begin navigating you need to install the software, activate the service and connect a GPS receiver. Note that you will need a GPRS Internet or 3G connection (only a WAP subscription is not sufficient – a full internet connection is needed) to activate and use the service. If you do not have a GPRS Internet subscription, please contact your network service provider.

Installation and activation

1. To start downloading the SuperFinder application to your phone, select 🛠-● and follow the instructions given.
2. When installation is complete, the Superfinder application will automatically start up and you will be asked to activate the service (if Superfinder does not start automatically, click on the SuperFinder icon in the Activity menu).
3. When SuperFinder starts, read and accept the User terms. Allow connection with the Internet by pressing Yes. If your mobile phone does not automatically detect an Internet Access Point, please contact your network service provider.
4. A view with three alternatives is shown. Highlight Activate and enter your activation code found in this manual. Thereafter, enter your phone number (add the country code, omit the zero of the area code, e.g. +44222111333). Select Send. Please note that this manual and the activation code printed on it is valuable information that should be kept for future reference!
5. Select your choice of map coverage from the list. Press OK.
6. Confirm your choice of map coverage by pressing OK once more.
7. The main menu of SuperFinder will be displayed.